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are identified by part number and applicable software (SW) version. 

This section tracks documentation changes. For a description of new software features and 

improvements introduced in a particular release, see the product release notes on the Eventide 
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 Section: 4.4.4.  The Timeline View 

October 28, 2009 

Part Number SW Description 

141114–02 v1.9.1 Clarified the use of the Play button and Space bar in the following sections: 

 Section: 2.3.  Retrieving and Playing a Record 

 Section: 4.4.5.  Playing Audio or Video Records 
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Added information about attaching files to an email: 
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141114–01 v1.9.0 Initial version of this document. Much of the information in this document was previously 
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  Global changes: 
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Changes and additions for v1.9: 
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Part Number SW Description 

 Video – added information to support this feature. See Section 4.4.5.  Playing Audio or 
Video Records. 

 Redaction – added new information to support this feature. See 4.4.4.  The Timeline 
View. 

 Grouped Playback – added new information to support this feature. See Section 
4.4.7.  Playback Modes. 

 Export Media – added new information to support this feature. See Sections 
4.5.  Exporting Record Data from an Incident and 4.6.  Exporting Record Data from 
Instant Recall. 

Notice Regarding Prior Documents 

Revision history was not tracked for documents prior to May 20, 2009 (141114–01, v1.9.0). 
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1.  MediaWorks Overview 

The Eventide® MediaWorks application allows you to search for, retrieve, and 

monitor audio and video recording data from Eventide® NexLog and Atlas 

Recorders. You can locate records by browsing or by searching. When searching 

for records, the use of filters allows you to refine your search. Once found, you 

will be able to arrange your records into incidents, listen to, and export their 

data, or burn the data to a CD. 

 Note: The term video applies to both screen capture data and video data. 

MediaWorks uses a simple but powerful layout scheme for its application 

windows. Most of the functionality in MediaWorks is controlled from a single 

top-level window. Advanced users can open multiple top-level windows if 

necessary. Each top-level window provides a tabbed interface, where each tab 

supports a distinct task such as Browsing, Searching, or Instant Recall. The 

organization of your windows is optionally saved into layouts, which can be 

retrieved at any time. These custom layouts, as well as the last window 

configuration used are remembered by MediaWorks between sessions. 

The primary MediaWorks user interface is the Main Window (see Section 

1.1.  The Main Window). In addition, MediaWorks includes a Menu Bar (see 

Section 3.2.  The Menu Bar) containing a number of items that let you quickly 

perform tasks.  

The Tools menu (see Section 3.2.3.  Tools Menu) on the Menu Bar includes an 

item called Options, which provides important capabilities for using the 

MediaWorks application (see Section 3.3.  Tools: Options). 

The Tools menu also includes an item called Archive List which allows you to 

print labels for archived data (see Section 4.11.  Printing Labels). 

1.1.  The Main Window 

The Main window, Figure 1, is the primary workspace for interfacing to a 

recorder using MediaWorks. You can open as many windows as needed. The 

Main window uses tabs located across the top of the window to organize 

information into different views. Clicking on a tab will cause that tab to be 

active. The default Main window contains a: 
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 Browse tab (see Section 4.1.1.  Browsing for Records) 

 Search tab (see Section 4.1.2.  Searching for Records) 

 Channels tab (see Section 4.9.1.  Channels Tab) 

 Recorders tab (see Section 4.9.3.  Recorders Tab) 

Figure 1. MediaWorks Main Window 
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2.  Getting Started 

The following topics provide information about installing the MediaWorks 

software and helping you to quickly understand and begin using the 

MediaWorks application. 

2.1.  Installing MediaWorks 

From the Eventide Client software CD, double-click on the installation MSI file. 

This will launch the MediaWorks Installer. Follow the prompts to install the 

MediaWorks application. 

By default, MediaWorks will install to the Eventide/MediaWorks directory where it is 

accessible to all users on your system. This version of MediaWorks can be 

installed over previous installations. 

You may change the location by clicking the Browse button and selecting a new 

location, but it is recommended that you accept the default installation location. 

When the installation is complete, a MediaWorks icon will display on your 

desktop. Additionally, during installation a .mediaworks directory is created in 

your User Documents and Settings directory. 

 Note: If this is an upgrade installation, all previous configuration files will 

automatically be upgraded the first time MediaWorks is run. 

2.2.  Starting MediaWorks and Adding a Source 

When starting MediaWorks for the first time, a prompt similar to the following is 

displayed: 

There are no active sources. Would you like to create some? 

You will enter at least one Eventide NexLog, Atlas or Eventide DIR911t Recorder 

as a source in the following instructions. 

Select Yes and the Options screen, Figure 2, is displayed with the Add source 

dialog box open (Figure 3). 
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Figure 2. Options Screen 

 

 

Figure 3. Add Source 

  

If the Add source dialog box is not open, select Sources from the list in the box 

on the left side of the Options screen, and click the Add button.  

To add a recorder as a source, enter the following information: 

1. Enter the IP address or host name of the recorder in the Server box. 

2. Enter a defined login name in the User box. 

3. Enter the password in the Password box.  

4. If you would like MediaWorks to remember your password, check the 

Remember Password box. 
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5. If you have enabled SSL for client connections on your NexLog recorder, you 

can check Use SSL to create a secure connection with the recorder. 

6. Click the OK button. If the information you entered is correct and the source 

is accessible, MediaWorks will connect to the source and it will be listed in 

the Sources box.  

7. After connecting to a source, close the Options dialog box. 

 Note: After your MediaWorks session, if you did not check the Remember Password 

box, each time you start MediaWorks you will be prompted to reconnect to a 

source (or sources) to which you had previously been connected. At each 

prompt, enter the password to connect to the respective source. 

For more information about adding a source, refer to 3.3.1.  Sources Options. 

2.3.  Retrieving and Playing a Record 

The quickest way to locate records is from the Browse tab in the Main Window 

(see Section 1.1.  The Main Window). When the Browse tab is selected, the pane 

on the left contains a list of recordings under the connected source and the date 

on which they were recorded. Clicking on the box to the left of a recorder drops 

down a list of dates. The sign in the box changes from a + to a -. Clicking on the 

box to the left of a date drops down a list of all the channels for that date in 

which one or more calls were recorded. Selecting a particular channel causes all 

of the records for that channel to be displayed in the upper right Record pane 

(see Section 4.4.2.  The Record View) of the Main Window. In addition, a 

‘timeline’ representation of all records on that channel, organized by start time, 

is displayed in the lower right hand pane (see Section 4.4.4.  The Timeline View) 

of the window. For additional information about locating records, see Section 

4.1.1.  Browsing for Records and Section 4.1.2.  Searching for Records. 

Once the records are displayed, press the Play button located in the Playback 

console (see Section 4.4.6.  The Playback Console) at the bottom of the window. 

The first record in the list will begin playing. To play a different record, highlight 

the new record in the upper right pane and press the Enter key or double-click 

on the new record. The graphic representation of the record will then also be 

highlighted in the lower right Timeline pane. Information about the record will 

be displayed continually in a box above the Playback controls. You can adjust 

the volume and playback speed of the record using the sliders to the left of the 

Playback controls. For additional information about playing records, see Section 

4.4.5.  Playing Audio or Video Records. 

Once you have retrieved records, a number of options are available. In addition 

to listening to the audio or viewing the video, you can export the data to disk. 

See Section 4.5.  Exporting Record Data from an Incident or Section 

4.6.  Exporting Record Data from Instant Recall. You can also burn the records 

to CDs; see Section 4.8.  Creating CDs. 
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Other tools are also available within MediaWorks, including: 

 Live channel monitoring (see Section 4.9.1.  Channels Tab) 

 Instant recall (see Section 4.9.2.  Instant Recall Tab) 

 Alarm monitoring (see Section 4.9.3.  Recorders Tab) 

 Archive Label Printing (see Section 4.11.  Printing Labels) 
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3.  MediaWorks User Interface 

The information about the MediaWorks user interface includes: 

 Section 3.1.  Working with Windows and Tabs 

 Section 3.2.  The Menu Bar 

 Section 3.3.  Tools: Options 

3.1.  Working with Windows and Tabs 

When you first start MediaWorks, only one top-level window will be shown. For 

most of the tasks you will perform with MediaWorks, this will be sufficient. For 

more flexibility multiple top-level windows can be created, Figure 4. To create a 

new top-level window, select New Window from the File menu, or press Ctrl-n. 

Top-level windows can be closed by clicking on the X in the top right corner of 

the window, or by pressing Alt-F4. 
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Figure 4. Multiple Top-Level Windows 

 

 Note: When the last top-level window is closed, the application will quit. 

To quit MediaWorks while multiple top-level windows are open, select Exit from 

the File menu or press Ctrl-q. When MediaWorks is restarted, it will restore the 

last known window configuration. 

Each MediaWorks window contains one or more tabs. By default, a Browse tab 

will be created when a new window is opened. Each tab corresponds to one of 

the major functions of MediaWorks: Browse, Search, Incident, Channels, Instant 

Recall, or Recorders. To open a new tab, select New Tab from the File menu. A 

submenu will appear with a list of possible tasks. Select a task from the 

submenu or press the corresponding hotkey. A new tab will appear containing 

the task. 

To switch between tasks (tabs), simply click on the desired tab (or press Ctrl-

Tab) to navigate forward or backward between tabs. When finished with a task, 

close the tab by right-clicking the tab and selecting Close Tab from the menu. 

 Note: You cannot close all tabs in a window; there must be at least one tab remaining. 

The Tab menu also includes other options. Select Close Other Tabs to close all 

other tabs except the one on which you have clicked. Select Detach Tab to 

remove the tab from the window in which it is currently located and place it in a 

new top-level window. 

If you are using multiple top-level windows, an additional Tab menu item will be 

available. By selecting Move To…, MediaWorks will present a list of all other 
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top-level windows. By selecting one, the current tab will be moved to the selected 

window. 

You can also change the order of tabs within a window, or between windows. To 

change the position of a tab within a window, click on and hold the tab. While 

holding the tab, drag it to the left or right. A green arrow will appear to assist 

you in positioning the tab. Release the mouse button over the desired spot in the 

window and the tab will be moved to its new location. You can use the same 

drag-and-drop technique to move a tab from one top-level window to another. 

 Hint: When using drag and drop, select the destination by pointing the tip of the 

cursor directly at a tab and then move it to the left or right until the cursor 

changes and a green arrow appears. Then drop it into position. 

3.1.1.  Layouts 

Advanced users of MediaWorks can take advantage of ‘layouts’ to save and 

restore frequently used window configurations. All aspects of the window 

configuration are saved when you create a layout, including the size and 

position of windows as well as the number of tabs that are open. 

Saving a Layout 

To save a layout, select Store Windows As from the Layout menu. A submenu 

will appear listing possible layout numbers from 1 to 10. Select the desired 

layout number and MediaWorks will save your current window configuration in 

that slot. 

You can also rename your layout by selecting Rename Layout from the Layout 

menu. Select the layout you wish to rename from the list and the Rename 

Layout dialog will appear. Enter the new layout name in the box and click the 

OK button. 

Restoring a Layout 

To restore a layout, select Layout from the Menu bar and then select the desired 

layout number (or layout name) from the drop-down list. All of the MediaWorks 

windows will close and your selected layout will be restored. 

 Note: MediaWorks will remember the last window configuration, as well as your saved 

layouts, when it closes. There is no need to save a layout each time MediaWorks 

is run. When MediaWorks restarts, it will automatically restore the last window 

configuration. 
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Importing and Exporting a Layout 

To import a layout or to export a layout to a file, see Section 3.3.13.  Layouts 

Options. 

3.1.2.  Columns 

Any data displayed in tabular format, particularly lists of records available in the 

Browse, Search, Incident, and Channel tabs, can be sorted in ascending or 

descending order, if applicable, by clicking on the header for that column. An 

indicator arrow will appear in that column indicating the sort direction. To 

change the sort direction, click on the column header again. 

Columns can also be re-arranged. To move a column to a new position, click on 

the column header, hold down the mouse, drag the column header to a new 

position, then release the mouse. The column will then re-position itself. 

The records in the Browse, Search, Incident, and Channel tabs can be further 

customized. Right-clicking on any area in the column headers displays a drop-

down menu of possible column names, Figure 5. To add a new column, check 

the box of the associated column name. To remove an existing column, uncheck 

the box associated with that column name. 

Figure 5. Column Drop-Down List 
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3.2.  The Menu Bar 

The Menu bar is located at the top of the MediaWorks window. A number of 

menu selections have shortcut keys associated with them and are displayed to 

the right of the menu selection. Also, if a menu selection includes an associated 

shortcut key, the shortcut key is shown parenthetically in the following 

descriptions. 

The Menu bar includes the following menu items: 

3.2.1.  File Menu 

Selecting File from the Menu Bar provides the following menu items: 

New Window (Ctrl+N) 

The New Window menu item opens a new top-level window. By default, the new 

window will contain a single Browse tab. 

New Tab 

The New Tab menu item opens a new tab in the active top-level window. Choose 

a tab name from the list that appears. The list includes: 

 Browse (Ctrl+B) 

 Search (Ctrl+T) 

 Incident (Ctrl+I) 

 Channels (Ctrl+L) 

 Instant Recall (Ctrl+R) 

 Recorders (Ctrl+E) 

Open Incident… (Ctrl+O) 

The Open Incident… menu item opens an existing local or remote incident in a 

new tab on the currently active top-level window. 

Close Tab (Ctrl+W) 

This menu item closes the active tab on the active top-level window. You cannot 

close the last tab on a window. 
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Save Incident (Ctrl+S) 

The Save Incident menu item saves the active incident. If an Incident tab is not 

active, this option is not available. 

Save Incident As… (Ctrl+Alt+S) 

This menu item saves a copy of the active incident by prompting for a new 

incident name. If an Incident tab is not active, this option is not available. 

Save All (Ctrl+Shift+S) 

Selecting the Save All menu item saves all open incidents in all windows. 

Print Records… 

This menu item opens the Print Records dialog box allowing you to print the 

current list of records. If a list of records is not in the active tab, this option is 

not available. 

More Reports… 

This menu item opens the Reports dialog box allowing you to print the following 

types of reports: 

 Channel Activity Summary 

 Daily Statistics Summary 

 Channel Activity 

Exit (Ctrl+Q) 

Selecting the Exit menu item closes all top-level windows and exits the 

MediaWorks program. 

3.2.2.  Edit Menu 

Selecting Edit from the Menu Bar provides the following menu items: 

Select All (Ctrl+A) 

The Select All menu item selects all records in the active tab. 
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Delete (Ctrl+D) 

Selecting the Delete menu item deletes the selected records on the active 

Incident tab. If an Incident tab is not active, this option is not available. 

Incident Properties (Ctrl+J) 

The Incident Properties menu item invokes the Incident Properties dialog box 

on the active Incident tab. If an Incident tab is not active, this option is not 

available. 

New Incident from Selected Records (Ctrl+Shift+I) 

This menu item creates a new Incident tab in the active window containing all 

the selected records. If a list of records is not available in the active tab, this 

option is not available. 

Set Loop Start to Current Time (Ctrl+[) 

This selection sets the “loop start” point to the value of the current playback 

time. This is only available on those tabs that can play audio from a record. 

Set Loop End to Current Time (Ctrl+]) 

This selection sets the “loop end” point to the value of the current playback time. 

This is only available on those tabs that can play audio from a record 

Set Export Start to Current Time (Ctrl+Shift+[) 

This selection sets the “export start” point to the value of the current playback 

time. This is only available on those tabs that can play audio from a record 

Set Export End to Current Time (Ctrl+Shift+]) 

This selection sets the “export end” point to the value of the current playback 

time. This is only available on those tabs that can play audio from a record 

3.2.3.  Tools Menu 

Selecting Tools from the Menu Bar provides the following menu items: 

Refresh (F5) 

The Refresh menu item refreshes the list of records in the active tab. 
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Stop (Esc key) 

Selecting Stop halts a record refresh that may be in progress. 

Save Search… (Ctrl+Shift+T) 

The Save Search menu item saves the current search filters and prompts for a 

search name. If the active tab is not a Search tab, this option is not available. 

Load Search 

This menu item loads a named search from a submenu into the active Search 

tab. If the active tab is not a Search tab, this option is not available. 

Create CD… (Ctrl+Y) 

This menu item opens the Create CD dialog box for the current list of records. 

Create CD Using Preset 

This menu item displays a list of configured presets for creating CDs. If one or 

more presets have not been defined, nothing will be displayed. 

Export… (Ctrl+Shift+Y) 

This menu item opens the Export Media dialog box for the current list of 

records. See Sections 4.5.  Exporting Record Data from an Incident and 

4.6.  Exporting Record Data from Instant Recall for additional information. 

Export Media Using Preset 

This menu item displays a list of configured presets for exporting media. If one 

or more presets have not been defined, nothing will be displayed. 

Email… 

This menu item opens the Attach files to email dialog box for the current list of 

records. See Section 4.7.  Attaching Files to an Email for additional information. 

Email Media Using Preset 

This menu item displays a list of configured presets for attaching files to emails. 

If one or more presets have not been defined, nothing will be displayed. 
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Archive List 

This menu item displays a list of connected recorders and their archive histories, 

allowing you to print labels that contain identifying information for the archive. 

For information on printing labels, see Section 4.11.  Printing Labels.  

Options… 

The Options… menu item opens the MediaWorks Options dialog box, where 

various applications settings can be adjusted. For additional information about 

the Options dialog box, see Section 3.3.  Tools: Options. 

3.2.4.  Playback Menu 

Selecting Playback from the Menu Bar provides the following menu items: 

Toggle Playback (Space bar) 

Checking the Toggle Playback box starts or stops playback. Starting or 

stopping playback in this way applies to either playback mode and applies to 

any tab. The space bar on the keyboard can also toggle playback on/off.  

Start Sequential Playback (Return key) 

The Start Sequential Playback menu item starts sequential playback on the 

selected record. If there is no selection, the first record in the list will begin 

playing. 

Start Grouped Playback 

The Start Grouped Playback menu item starts grouped playback on the 

selected records. Grouped playback is single play only and occurs when one 

record is related to another record in the database. For example, an audio record 

on one channel may have a related video record on another channel. 

Start Mixed Playback (Shift+Return key) 

The Start Mixed Playback menu item starts mixed playback on the selected 

record. If there is no selection, the first record in the list will begin playing. 

Next Record (Shift+Right arrow) 

In sequential mode, Next Record skips to the next record as listed in the record 

view. In mixed mode, Next Record skips to the start of the next record in time 

order. 
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Previous Record (Shift+Left arrow) 

In sequential mode, Previous Record skips to the previous record as listed in 

the record view, or skips to the beginning of the current record, depending on 

the time that the current record has been playing. If the current record has been 

playing for less than 3 seconds, it will skip to the previous record. If the current 

record has been playing for more than 3 seconds, it will skip to the beginning of 

the currently playing record. 

In mixed mode, Previous Record skips to the start of the previous record. 

Skip Forward (Right arrow) 

The Skip Forward menu item scrubs forward by a user-defined number of 

seconds (default is 10). In sequential mode, scrubbing remains within the 

bounds of the currently playing record. 

Skip Back (Left arrow) 

The Skip Back menu item scrubs backward by a user-defined number of 

seconds (default is 10). In sequential mode, scrubbing remains within the 

bounds of the currently playing record 

Loop Playback 

Checking the Loop Playback box loops playback between user-defined start and 

end looping points. In Sequential mode, if no user-defined start and end looping 

points have been set, the entire record will be looped. If start and end points 

have been set within the record, checking Loop Playback will initiate loopback 

between these two points. 

In Mixed mode, if no user-defined start and end looping points have been set, 

the entire record set will be looped. If start and end points have been set within 

the record set, checking Loop Playback will initiate loopback between these two 

points. 

Skip Inactive Audio/Video Periods 

Checking the Skip Inactive Audio/Video box causes MediaWorks to skip 

inactive periods between records when playing in Mixed mode. In Mixed mode, 

MediaWorks always proceeds in time order and there may large gaps of silence 

or no data separating records. By default, MediaWorks will skip over any gaps 

and begin playing the next record. Disabling this option will force MediaWorks to 

play the inactive periods in real time. 
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Talking Time 

Checking the Talking Time box enables talking time during audio playback. 

Depending on the talking time options you have selected, MediaWorks will 

announce the time at various intervals while audio is being played. See Section 

3.3.10.  Talking Time Option for details on how to customize the behavior of 

talking time. 

Single Play 

Checking the Single Play box stops playback in sequential mode after the data 

finishes playing for a record. If disabled, playback continues to play each record, 

as listed in the record view, until the end of the list is reached. 

3.2.5.  View Menu 

Selecting View from the Menu Bar provides the following menu items: 

Follow Playback 

Checking the Follow Playback box will cause the playback indicator to remain 

centered in the timeline as the record is playing. 

Loop Markers 

Checking the Loop Markers box enables the display of loop start/end points in 

the timeline. 

Export Range Markers 

Checking the Export Range Markers box enables the display of export 

start/end points in the timeline. 

3.2.6.  Layout Menu 

Selecting Layout from the Menu Bar provides the following menu items: 

Layout 1 (Ctrl+1) 
Layout 2 (Ctrl+2) 
 

 

 

Layout 9 (Ctrl+9) 
Layout 10 (Ctrl+0) 

This menu item activates a layout. There are slots for ten predefined layouts. 



   

 MediaWorks User Manual v2.1  Chap. 3.  MediaWorks User Interface  21 

Store Windows As 

The Store Windows As menu item saves all top-level windows into a layout for 

later recall. 

Rename Layout 

The Rename Layout menu item displays a Rename Layout dialog box which 

allows you to assign the layout a more descriptive name other than Layout x. 

3.2.7.  Help Menu 

Selecting Help from the Menu Bar provides the following menu items: 

Contents… 

Selecting Contents… from the Help menu activates the MediaWorks HTML 

Online Help, Figure 6. This allows you to access MediaWorks topics from the 

Contents, Index, or Search tabs. 

Figure 6. Contents Online Help 
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Frequently Asked Questions… 

Selecting Frequently Asked Questions… from the Help menu invokes the 

MediaWorks Frequently Asked Questions help. 

What’s this? (Shift+F1) 

Selecting What’s this? from the Help menu or pressing the Shift + F1 keys 

displays a question mark (?) to the right of the cursor. Moving the question mark 

to an area of the screen and then clicking will display a brief explanation about 

the selected field or screen area. See Figure 7. 

Figure 7. What’s This? Online Help 

 

About 

Selecting About from the Help menu provides information about this release of 

MediaWorks. 

3.3.  Tools: Options 

The Options screen, Figure 8, provides advanced options for working with 

MediaWorks. Through the Options menu, you can perform a number of tasks 

and adjustments to MediaWorks. 
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Figure 8. Options Screen 

 

The options are described in the following sections. 

3.3.1.  Sources Options 

These options allow you to add a MediaWorks source, or, once added, to 

connect, disconnect, or remove a source, or view source properties. To add a 

new connection to an offline archive, see Section 4.10.1.  Accessing Archives on 

a Network or Local Drive. 

To add a new connection to a recorder, click the Add button. In the Add source 

dialog box that appears, enter the following: 

 Server: Enter the IP address or host name of the recorderto which you wish 

to connect. 

 User: Enter a defined login name. 

 Password: Enter the password. 

 Remember Password: (Optional) Check this box to instruct MediaWorks to 

remember the password. Then, in the future, MediaWorks will log into the 

source without prompting for a password. 

Then click the OK button to add the selected source. 

All connected resources will be reconnected when restarting MediaWorks. 

To completely remove a source from the list, select the source and then click the 

Remove button. 

After a source has been added, you can connect and disconnect from any source 

in the list, as necessary, without having to go through the process of adding a 

source. To disconnect from a source, select the source and click the Disconnect 
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button. To reconnect to that source, select the source and click the Connect 

button. 

To view the properties of a source, highlight the source and then click the 

Properties button. A Properties screen will be displayed, listing the properties 

for the selected source. 

3.3.2.  General Options 

The General options allow you to enable or disable general MediaWorks 

application settings. These options include: 

Visual Style 

This allows you to choose a visual style; the options are a fully supported 

standard MediaWorks style, and experimental support for the Windows Current 

theme. 

Warn when closing a window with multiple tabs 

When enabled (checked), MediaWorks will warn you before closing a window 

containing multiple tabs so that you do not lose the information. If this selection 

is disabled, the windows will close without any warning. 

Enable Automount 

If this selection is enabled, MediaWorks will actively monitor your drives for the 

presence of archive media (for example, archive media on a DVD-RAM disk) and 

mount it as source, if found. 

Show Timezone Offset 

Enable this selection to display the offset from Universal Time Coordinates (UTC, 

a.k.a. Greenwich Mean Time) in instances where the date and time are 

displayed. 

Notify when new Alarms appear 

Enable this selection to be notified when new alarms appear on any of your 

connected sources. 

Do not notify on Recorders tab 

Check this box if you have the Recorders tab open often and you do not want 

the duplicate alarm notification. 
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Make notifications audible 

Enable this option to have a sound play when the Alarm notification box is 

visible. 

Repeat audible alert (every 5 seconds) 

Enable this option to have your chosen sound loop for as long as the Alarm 

notification message box is visible. 

Audible alert sound 

You may choose any of the following default system sounds, or choose your own 

sound to be played, if Make notifications audible is enabled: 

 Exclamation 

 Asterisk 

 Default Beep 

 Hand 

 Question 

 Choose a file from disk… 

Enable ‘drag selection’ in record view 

Enable this selection to perform selections while clicking + dragging in the 

record view. This is a more advanced method of record selection, and requires 

you to release the mouse and click again to start a drag operation when copying 

records to an incident. 

Maximum query threads 

This selection allows you to adjust the number (1 to 99) of simultaneous server 

queries supported by MediaWorks. The higher you make this number, the more 

responsive MediaWorks will be when used heavily. It is recommended that you 

leave this number at the default value of 5. 

Elevate Configuration Button 

Click on this button to copy your current MediaWorks configuration to the 

machine defaults. You must have Administrator privileges to perform this 

function. 
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3.3.3.  Channel Groups Options 

A Channel Group is a collection of one or more channels. MediaWorks uses 

Channel Groups in the Search and Instant Recall tabs.  

In the Search tab, Channel Groups are displayed in the same list as the 

connected sources. Use Channel Groups to organize frequently used channel 

names, even across sources, to make browsing and searching easier. 

In the Instant Recall tab, Channel Groups can be selected as the active filter. 

This allows Instant Recall to monitor more than one channel at a time. 

To create a new Channel Group, select Channel Groups from the Options list. 

The Options screen will display a Sources list and a Groups list. Click on the 

Add Group button. You will be prompted to enter a Group Name. After the 

group has been created, it is initially empty. Add channels to the group by first 

selecting one or more channels from the Source list on the left. Then press the 

arrow button to add the selected channels to the group. You can add channels 

from a different source by selecting another source from the drop-down list 

above the channel list. 

You can edit an existing Channel Group by selecting it from the Groups list on 

the right. Remove individual channels from a group by first selecting them and 

then clicking the Remove Channel button. You can remove an entire Channel 

Group by selecting the group and clicking the Remove Group button. 

3.3.4.  Filters Options 

Filters are used in Instant Recall to limit the live record view. A filter is a single 

channel name, or Channel Group. Use the Filters options to define which filters 

are visible in an Instant Recall tab. 

To add a Channel Name filter, select one or more channels from the Channels 

list and click the associated arrow button. To add a Channel Group filter, select 

one or more groups from the Groups list and click the associated arrow button. 

The order in which the filters appear in the Instant Recall tab can also be 

adjusted. To change the order of filters, select one or more filters from the 

Visible list and then click the up or down arrow to change the relative order. 

To prevent a filter from showing up in the Instant Recall, select the filter from 

the Visible list and click the Remove Filter button. 

3.3.5.  Instant Recall Options 

The Instant Recall options allow you to adjust settings that affect the Instant 

Recall tab. These options include: 
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Maximum Records 

Since Instant Recall is intended to monitor recent channel activity, there is a 

maximum record limit to each Instant Recall tab. The Maximum Records option 

allows you to set the limit for the number of records, although it is 

recommended that this value be left at the default setting of 5000 or lower. 

Increasing the number may impact performance. 

Hours/Minutes (Display Time) 

Each Instant Recall tab contains a default time window, within which records 

are displayed. You may change the time by adjusting the Hours: and Minutes: 

values. 

 Note: Depending on your user account, the amount of time you can set may be limited 

by your system administrator. 

3.3.6.  Playback Options 

The Playback options allow you to adjust global playback behavior. These 

options include: 

Ignore Audio Discontinuities 

Certain analog capture boards are occasionally prone to small continuity jitter, 

while recording audio. To suppress warnings about these audio anomalies, 

check this box. To see all audio continuity warnings while playing audio, leave 

this box unchecked. 

Double click starts related call playback 

Checking this box allows you to start playback in Grouped mode by double-

clicking on the record. 

Skip Interval 

Adjust the Skip Interval to specify the number of seconds to be scrubbed 

forward or backward when using the Skip Forward or Skip Back menu 

selections from the Playback menu (See Section 3.2.4.  Playback Menu) or the 

skip forward (>>) or skip back (<<) controls on either side of the slider in the 

Playback Console (see Section 4.4.6.  The Playback Console). 

3.3.7.  Export Presets Options 

The Export Presets options allow you to rename or delete previously created 

presets for either exporting media or creating CDs. 
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3.3.8.  Default Columns Options 

The Default Columns options allow you to specify the default columns to be 

displayed when opening a new Browse, Search, or Incident tab. From the 

available column list on the left, select a column to add and click the right arrow 

button. The column will then move to the box on the right. To remove a column, 

select one from the list on the right and click the left arrow button. The order in 

which the default columns are displayed can also be defined; select a column 

from the list on the right and adjust its position by clicking on the up or down 

arrow button. 

3.3.9.  Searches Options 

You may use the Searches options to manage your searches. Searches are used 

in the Search tab to provide a quick means to recall various queries. Searches 

can be added, edited, or removed using the buttons on the right. In addition, 

individual searches can be exported to a disk. Select a search from the list and 

click on the Export… button. Supply a filename for the search and the search 

will be exported into that file. Exported searches can be sent to other users via 

email. 

To import a search, click on the Import… button and navigate to the location of 

the search file. 

3.3.10.  Talking Time Options 

When activated during audio playback, Talking Time can speak in defined 

intervals. If necessary, you can adjust the value of these intervals with the 

Talking Time options. These options include: 

Intervals of 

Checking this box enables Talking Time and defines the intervals in seconds. To 

disable Talking Time, uncheck this box. 

Beginning of call 

If Talking Time is enabled, checking this box will cause the time to be 

announced at the beginning of a call. 

End of call 

If Talking Time is enabled, checking this box will cause the time to be 

announced at the end of a call. 
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Say local time 

If this box is checked, the time announced will be local time. 

Pan Settings 

Talking Time can be panned to either the left or right speaker, or sent to both 

speakers simultaneously. Adjust the pan settings to your preference. 

Talking Time Volume 

The Talking Time volume applies whenever Talking Time is activated during 

audio playback. Moving the slider to the right increases the volume; moving it to 

the left decreases the volume. 

Speaking Voice 

You may select the Talking Time voice. The default is English Male 1. 

3.3.11.  Timeline Options 

Timeline options apply to the Browse, Search, and Incident tabs. These options 

include: 

Show UTC time in the timeline ruler 

Check this box to use Greenwich Mean Time (UTC) as the displayed time in the 

timeline ruler. If this box is not checked, then UTC time will be displayed as an 

offset. 

Show thumbnails if available 

Check this box to display thumbnails (when provided by the source) for video 

records in the Timeline. 

Fields 

By default, the Timeline will group record information by Channel Name. You 

may add groupings by adjusting the Fields settings. To add a grouping, select it 

from the Available Fields list on the left and click on the right arrow. To remove 

a grouping, select it from the Timeline list on the right and click on the left 

arrow. 

As an example, if you configure only a single grouping such as Source Name, all 

records will be grouped into a single broad category. Since the Timeline displays 

all records in time order, from earliest to latest, this may cause some records to 



   

30  Chap. 3.  MediaWorks User Interface MediaWorks User Manual v2.1   

be displayed on top of each other in the Timeline (since it is very likely that 

many records will occur at the same time on a single source). 

To distinguish between channels in a source, add additional groupings so that 

no records are grouped in a way that crosses time boundaries. In this example, 

we might add an additional Channel Name field as a second-level grouping to 

distinguish from each other among various records on a source. 

3.3.12.  Video Options 

The Video options allow you to include the time in the video display. These 

options include: 

Show Time in the video display 

Check this box to include the time, as defined in the Recorder Setup 

configuration, in the video display.  

Show UTC time in the video display 

Check this box to show the time as Universal Time Coordinated (UTC, a.k.a. 

Greenwich mean time) in the video display. 

3.3.13.  Layouts Options 

Configure up to ten layout presets using these options. Rename a selected 

layout by clicking the Rename button. Layouts can also be imported and 

exported in order to share them with other users. Select a layout and click on 

the Export button to save the layout as a file. Other layouts may be imported by 

clicking on the Import button. 

 Note: The currently selected layout will be replaced by the imported layout. 

3.3.14.  Change Password Options 

For those sources that support it, your current password can be changed. Select 

a source from the list and enter your new password in the New password: box. 

Enter the new password again in the Repeat new password box and then click 

on the Apply button. Your password will now be changed on the source 

recorder. 
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  

4.  Using MediaWorks 

MediaWorks provides several ways to locate, organize, (see Section 4.1.  Locating 

and Organizing Records) and monitor (see Section 4.9.  Monitoring Recorders) 

data stored on Eventide recorders. Once records have been found, the data can 

be organized into incidents (see Section 4.2.  Creating an Incident). The records 

can also be examined, updated and listened to (audio records) or viewed (video 

records). With MediaWorks you can also monitor different aspects of the 

recorder, including live feeds, call activity, and system alerts and status. 

The data for each record can be exported in a number of different ways, or 

burned to a CD. 

The information about using MediaWorks includes: 

 Section 4.1.  Locating and Organizing Records 

 Section 4.2.  Creating an Incident 

 Section 4.3.  Updating Records 

 Section 4.4.  Viewing and Playing Records 

 Section 4.5.  Exporting Record Data from an Incident 

 Section 4.6.  Exporting Record Data from Instant Recall 

 Section 4.7.  Attaching Files to an Email 

 Section 4.8.  Creating CDs 

 Section 4.9.  Monitoring Recorders 

 Section 4.10.  Accessing Archives 

 Section 4.12.  Generating Reports 

4.1.  Locating and Organizing Records 

The typical process for finding and organizing records includes the following 

steps: 

 Browse or search for record data on the recorder. 
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 Create and save Incidents by selecting individual records or groups of 

records and organizing them into incidents. 

 Export the data in a variety of formats or archive the data from incidents 

onto a CD. 

4.1.1.  Browsing for Records 

The simplest method for locating records on the recorder is provided by the 

Browse tab, Figure 9. When viewing a Browse tab, all of the connected sources 

appear in the list box on the left side of the main window. If no sources are 

connected, see Section 3.3.1.  Sources Options for information about connecting 

to a source. Below each source, a list of months corresponding to the available 

data on the recorder will appear after you click on the + sign next to the source. 

Clicking on a + sign next to a month will display all of the days in that month 

that data was recorded. Clicking on a + sign next to a day will open a list of 

channels on that recorder that contain the data for the day selected. When you 

click on a channel, MediaWorks retrieves the records for that channel and 

displays them in the upper right pane of the main window. 

Figure 9. Browse Tab 

 

 

To retrieve records for a different day, expand the tree for the appropriate day 

and click on the desired channel. The records for that channel will then be 

retrieved and displayed. 
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The Browse tab can display the list of channel in two modes: Channel Name or 

Channel Number. The default is Channel Number. To change the display mode, 

click on Show… at the top of the left pane and select the mode from the drop-

down menu. When viewing the information by Channel Number, each physical 

channel on the recorder will be listed separately in the Browse tree, preceded by 

its channel number. When viewing by Channel Name, each physical channel on 

the recorder will be listed separately in the Browse tree, preceded by its channel 

name. 

4.1.2.  Searching for Records 

MediaWorks provides a powerful interface for advanced record retrieval in the 

Search tab, Figure 10. When viewing the Search tab, a list of search criteria in 

the form of Filters is provided in the left pane. Clicking on Filters… at the top of 

the pane displays a drop-down list of filters. 

Figure 10. Search Tab 

 

Each element of a search is contained within a search “panel” in the left pane of 

the Search tab. The Date and Channel panels are always required, so you must 

provide, at a minimum, a value for these criteria to conduct a search for records. 

When more filters are added, additional panels will appear as needed. If 

necessary, scroll the search panel to view the additional panels. Each filter panel 

can be compressed or expanded by clicking on the arrow located in the upper 

left corner of the pane. 
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Creating a Search 

To create a search, first select one or more days from the Date filter area. Dates 

can be selected by clicking on the calendar (default), or by specifying a date 

range or relative time period. To change the way a date filter is specified, click 

the down arrow in the upper right corner of the Date filter panel and choose the 

desired mode from the drop-down menu. The modes include Calendar (default), 

Date Range, and Relative. 

Next, one or more channels can be included in the search by selecting them in 

the Channel filter panel below the Date panel. The Channel filter displays 

channels for each connected source. If there are no connected sources, see the 

Sources options (Section 3.3.1.  Sources Options) for information about 

connecting to a source. Any number of channels can be selected, across any 

number of sources. Channels can be selected by Channel Number (default) or by 

Channel Name. To change the way the Channel filter is displayed, click the 

down arrow in the upper right corner of the Channel filter panel and choose the 

desired mode from the drop-down menu. 

Initiating a Search 

To initiate a search, click on the Search button at the top right in the Search 

pane or press the F5 key on the keyboard. All records that meet the search 

criteria will be displayed in the top left pane of the window.  

4.1.3.  Using Additional Filters 

You may narrow your search by specifying additional filters, such as Call 

Length or Protected. To add an additional Search filter, click on Filters… and 

select a filter from the drop-down list. The selected filter will be displayed below 

the Channel filter area. More filters can be added, if necessary. Each new filter 

will appear as an additional panel. 

 Note: Some additional filters are standard on all recorders and will always appear on 

the drop-down list. Other additional filters depend on the custom fields included 

in the record table. Some or none of these filters may be included on the drop-

down list of your recorder. 

To remove a filter, click the X button which appears in the title bar of each 

optional filter. Alternately, deselect the filter from the Filters… drop-down list. 

Once removed, the filter will not be used in subsequent searches. 

Standard Additional Filters 

The following standard additional filters appear in the Filter drop-down list of all 

recorders. 
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Call Length 

Enter the minimum and maximum call durations. MediaWorks will search for all 

records equal to or between these values. 

Call Note 

Enter text in the Note box. MediaWorks will perform a search for all records that 

contain this text string in the Notes field. Check the Case sensitive? box if you 

wish to make the search match case as well. 

PIN 

For installations that use a PIN code, enter the PIN number. MediaWorks will 

include this as part of the search criteria. 

Protected 

Search for all records that are protected, or all records that are unprotected. 

Telephone 

Enter the telephone number digits. Check the Search DTMF box to find records 

which match the telephone number in the DTMF field. Check the Search Caller 

ID box to find records which match the telephone number in the Caller ID field. 

Call Direction 

This filter only applies to records that contain data in the Caller ID or DTMF 

fields. Enable Incoming to find records that match incoming calls. Enable 

Outgoing to find records that match outgoing calls. Enable Unknown to match 

records that could not be identified as either incoming or outgoing. Enable Use 

DTMF and Caller ID to determine to use heuristics on the data in the Caller ID 

and DTMF fields to determine call direction. 

Suppressed 

Check Show suppressed to search for records that were suppressed on the 

recorder. Check Show unsuppressed to search for records that were 

unsuppressed on the recorder. Check Show forced to search for records that 

were forced into recording on the recorder. 

Audited 

Check Show accessed to search for records have had their data accessed by 

client applications. Check Show not accessed to search for records that have 

not had their data accessed by client applications. 

Deleted 

Click on Show deleted to search for records that do not have audio or video 

data associated with them (as may happen when the recorder purges data 

periodically when archiving records). Click on Show not deleted to search for 

records that do have data associated with them. 
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Custom Additional Filters 

These additional filters are based on the custom fields that have been added to 

the call properties for this recorder. Enter the string as it appears in the More 

tab of the Call Properties screen. 

Following are some typical examples of additional custom filters which may or 

may not appear in the Filter drop-down list of your recorder, depending on your 

particular custom fields. 

City 

Search for records that have a specific city name associated with them. Enter 

the city name string the Search for: box. 

Customer Name 

Search for records that have a specific customer name associated with them. 

Enter the customer name string in the Search for: box. 

Gps Coordinates 

Search for records that have GPS coordinates associated with them. Enter the 

GPS coordinates string in the Search for: box. 

Radioid 

Search for radio call records that have Radioid information associated with 

them. Enter the Radioid string in the Search for: box. 

State 

Search for records that have a specific state associated with them. Enter the 

state string in the Search for: box. 

Street Address 

Search for records that have a specific street address associated with them. 

Enter the street address string in the Search for: box. 

Subject 

Search for records that have a specific subject associated with them. Enter the 

subject string in the Search for: box. 

Talkgroup 

Search for records that have a specific talk group associated with them. Enter 

the talk group string in the Search for: box. 

Time 

Search for records that have a specific time associated with them. Enter the time 

string in the Search for: box. 
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User Id 

Search for records that have a specific user ID associated with them. Enter the 

user ID string in the Search for: box. 

4.1.4.  Saving Searches 

Searches can be saved and recalled at a later time. Select Save Search… from 

the Tools menu. This will invoke the Save Search dialog box. Provide a unique 

name for the search in the Name field. You an elect to save the Date and 

Channel criteria of the search by checking the Include Dates and Include 

Channels boxes. By not checking these boxes, the Date and Channel criteria 

will not be restored when the search is later recalled. This can be useful for 

saving searches that contain a fixed set of filters, but need to be frequently 

adjusted for date and channel criteria once they are recalled. 

Select the Properties tab in the dialog box to verify or adjust the search criteria 

before saving the search. Saved searches can be edited. 

4.1.5.  Loading Saved Searches 

At any time, a saved search can be loaded into the currently active Search tab. 

Select Load Search from the Tools menu and select the named search from the 

list of available searches. The search will be restored into the currently active 

Search tab. If the search being loaded specifies Include Dates and/or Include 

Channels, those search criteria will also be loaded, otherwise they will not be 

included. To execute the search, click the Search button. 

4.2.  Creating an Incident 

In MediaWorks, an incident contains a group of related records. To find records, 

see Section 4.1.1.  Browsing for Records and Section 4.1.2.  Searching for 

Records. Once a set of records has been found, the next step is to group them 

into related sets known as “incidents.” New incidents can be created from a 

selection of records, or records can be appended to existing incidents. Incidents 

form the foundation for many of the other MediaWorks functions, such as 

exporting record data or burning CDs with record data. Incidents can also be 

shared with other users by emailing them or saving them to a shared location on 

an Eventide recorder. 

Incidents can be stored locally on your computer, or remotely on a recorder. To 

create a new incident, select New Tab from the File menu and then select 

Incident from the drop-down list. An empty Incident tab will be created. To 

create a new incident with an initial set of records, first select the records from 

the Record view or Timeline view. Then right-click and select New Incident from 
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Selected Records from the drop-down menu. A new incident tab, Figure 11, will 

be created containing the records you selected. 

Figure 11. Incident Tab 

 

An incident can also be populated with records in several other ways. From the 

Browse or Search tab, a group of records can be copied to an incident using 

drag-and-drop. With the Browse or Search tab open, select one or more records. 

Then click the selected records and, while holding the mouse button down, drag 

the records to the new Incident tab. Release the mouse over the Incident tab and 

the records will be added to that incident. If you are using multiple top-level 

windows, records can be dropped directly on the record view in the destination 

Incident tab. 

Alternatively, records can be added directly to an incident by first selecting one 

or more records from the Browse or Search tab. Then right-click on the selection 

and choose Add to incident from the menu that appears. Select the desired 

incident from the sub-menu and the selected records will be added to that 

incident. 

Once an incident has been created and populated with records, you have a 

choice of saving the incident locally on your computer or saving the incident 

remotely to a recorder. 

4.2.1.  Saving an Incident Locally 

To save an incident locally to a file on your computer, first make sure the 

Incident tab is selected. Then select Save Incident from the File menu. If this is 
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a new incident, when the Save Incident dialog box appears, choose the Local tab 

and enter a File name for the incident. 

Optionally, check the Save Audio With Incident box to have MediaWorks 

download all the media for each record in the incident. This will allow other 

users to listen to the audio or view the video without having a connection to 

your recorder. 

 Note: The amount of audio or video could be quite large, depending on the number of 

records in the incident. In this case, it may take a few moments to download the 

media for each record, and the resulting file will grow accordingly. 

Check the Password Protect Incident box to have MediaWorks encrypt the 

incident with a case-sensitive password. As the local incident is saved, you will 

be prompted for a password. Enter any combination of numbers and letters, and 

MediaWorks will encrypt the incident using this password. Anytime the incident 

is opened, you must provide the correct password to proceed. Then, click OK. 

4.2.2.  Saving an Incident Remotely 

To save an incident remotely on a recorder, first make sure the Incident tab is 

selected. Also, check that all records in the incident belong to the same recorder. 

Then select Save Incident from the File menu. If this is a new incident, when 

the Save Incident dialog box appears, choose the Remote tab and check that the 

correct recorder is listed in the Recorder box. The incident will be saved to the 

selected recorder. 

Optionally, check the Shared box to allow other users connected to the recorder 

to open the incident after it is saved. Check the Protect Calls in Incident to 

automatically mark all records as protected when saving the incident. Enter an 

Incident Name and then click OK. 

4.2.3.  Adding and Deleting Records from an Incident 

Once created, an incident can be further expanded or reduced. To add records to 

an open incident, first select the desired records from the Browse or Search 

tabs, or another Incident tab. Once selected, click and drag the selection to the 

destination Incident tab and then release it. The records will be appended to 

that incident. 

Alternatively, after having selected the records you wish to add, right-click the 

selection and choose Add to incident from the menu that appears. A submenu 

lists all possible destination incidents. Select the desired incident and the 

records will be appended to it. 

To delete records from an incident, select the records you wish to delete from the 

Incident tab they are associated with and select Delete from the Edit menu. 

Alternatively, you can right-click the record selection and choose Delete from 

the menu that appears. 
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4.3.  Updating Records 

Once records have been collected into incidents, there are a number of ways to 

examine their properties. In addition to various reports which can be run, 

records can be sorted in any direction using the available columns. Examine 

detailed properties for any record by right-clicking a record and selecting 

Properties from the menu. The Properties dialog box will appear, allowing you to 

add information such as notes and to access the audit history of the record. 

Any notes modified in this dialog box are saved back to the recorder on which it 

originated. Similarly, changing the Protected status of a record updates the 

record’s status on the source recorder. 

4.3.1.  Properties Screen 

The Call Properties screen lists the attributes of the selected call record and 

includes the following tabs: 

 Properties – provides information about the call properties. See Figure 12. 

 More – allows you to add information about the call. See Figure 13. 

 History – Provides a history of the call. See Figure 14. 

Properties Screen – Properties Tab 

The Properties tab provides detailed information about the record’s location, 

time, and phone. You may add information about the record in the Notes box. 

Check the Protected box in the Attributes section to prevent the record from 

being deleted. 
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Figure 12. Record Properties Screen –Property Tab 

 

Properties Screen – More Tab 

The More tab includes the custom fields specific to your recorder that contain 

additional information about the record. From this screen, you may edit any of 

the custom field information. 

Figure 13. Record Properties Screen –More Tab 
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Properties Screen – History Tab 

The History tab provides an audit history of each time this record has been 

accessed, including the related user information. 

Figure 14. Record Properties Screen –History Tab 

 

4.4.  Viewing and Playing Records 

After you have found and organized records, as described in Section 

4.1.  Locating and Organizing Records, you may view and play the records. 

4.4.1.  Viewing Records 

Records displayed in the Browse, Search, or Incident tabs are shown in two 

different ways simultaneously. The first is a simple tabular list displayed in the 

upper right-hand pane, the record view. This view can be customized in that it 

supports a number of different column and sorting options. The second is a 

chart of records displayed in the lower right-hand pane referred to as the 

timeline. The timeline can also be customized, but only supports a single 

method of displaying the record data by time. 

Together, the record view and timeline view provide a comprehensive look into 

the same set of data. Selections between the two views are synchronized; any 

records selected in one are automatically selected in the other. Similar 
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operations may be performed from each view, including playback, exporting, and 

record editing. 

4.4.2.  The Record View 

The record view in the upper right-hand pane presents record data in tabular 

format, Figure 15. You may sort the information by clicking on the appropriate 

column head. A small arrow will indicate the sort direction. To reverse the sort, 

click the column head again. Columns can also be reorganized. Click and drag 

any column head to a new position. The type and number of columns can also 

be customized. Right click any column and a menu of available column names 

will appear. Select a column name from the list. You may also add or delete a 

column from this menu. 

To reset the columns to their user-defined default values, select the Reset to 

Default option. 

Figure 15. Record View 

 

4.4.3.  Record View Menu Options 

Selecting a record in the Record view and then right-clicking on that record 

causes the Record View menu to appear, Figure 16. 
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Figure 16. Record View Menu 

 

 

The Record View menu selections include: 

 Properties – See Section 4.3.1.  Properties Screen. 

 Protect – Checking this box prevents the selected record from being deleted. 

 New Incident from Selected Records – See Section 4.2.  Creating an 

Incident. 

 Add to incident – See Section 4.2.3.  Adding and Deleting Records from an 

Incident. 

 Start Sequential Playback – See Sequential Playback Mode. 

 Start Grouped Playback – See Grouped Playback Mode. 

 Start Mixed Playback – See Mixed Playback Mode. 

 Create CD… – See Section 4.8.  Creating CDs. 

 Create CD Using Preset – See Section 4.8.  Creating CDs. 

 Export… – See Section 4.5.  Exporting Record Data from an Incident or 

Section 4.6.  Exporting Record Data from Instant Recall. 

 Export Using Preset – See Section 4.5.  Exporting Record Data from an 

Incident or 4.6.  Exporting Record Data from Instant Recall. 

 Email… - See Section 4.7.  Attaching Files to an Email. 

 Email Using Preset – See Section 4.7.  Attaching Files to an Email. 
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4.4.4.  The Timeline View 

The Timeline view in the lower right-hand pane, Figure 17, shows the same set 

of records that are displayed in the Record view, but presents the record data in 

a linear chart. The timeline always presents information in “time order”, from 

earliest to latest. Each record is organized into groups by channel name and 

displayed in chronological order from left to right. The individual records are 

drawn in the timeline in the horizontal direction in relation to their duration. 

Scroll the timeline to the right to view records that are not visible. If more than 

one channel is represented in the data, scroll the timeline up or down to display 

channels that may not be initially visible. 

Figure 17. Timeline View-Audio Record 

 

You can increase or decrease the height of the channel display by clicking on the 

large or small magnifying glass respectively in the upper right corner of the 

display. You may also adjust the time length of the timeline. To view more 

records, decrease the time length of the channel display by clicking on the small 

magnifying glass in the lower right corner of the display. To view fewer records 

and expand the length of time displayed for each record, click on the large 

magnifying glass in the lower right corner of the display. 

Multiple records can be selected by using a “rubber band.” Click the mouse 

button somewhere in the Timeline and drag the rubber band so that it 

encompasses additional records. Release the mouse button and all of the 

records within the rubber band will be selected. 

The Timeline view supports the same options as the record view. All operations 

that can be performed in the Record view can also be performed in the Timeline 

view. In particular, initiating Mixed mode playback from the timeline is 

recommended. Right-click on a record in the timeline and select Start Mixed 

Playback from the menu. This initiates Mixed mode playback at that point. 

For video records, the Timeline view shows a series of thumbnails for each 

channel. See Figure 18. The thumbnails are snapshots of the video taken at 

intervals determined on the recorder. The video records can be played the same 

way as audio records. In addition, double-clicking on a thumbnail will display 

the video record in a new window above the Record view. 
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Figure 18. Timeline View-Video Record 

 

Playback Settings 

In the Channel Name box on the left there are a number of playback settings 

that you can set on a channel-by-channel basis. They include: 

 

Mute button - Clicking on the mute button (green speaker icon) to the left of the 

down arrow mutes the sound on the selected channel. The button will then be 
grayed out. Clicking on the grayed-out mute button will restore the sound to that 
channel. 

Clicking on the down arrow displays a menu with the following selections: 

 Options… - Clicking on this menu item displays an Options dialog box. (See 

Playback Settings Options below.) 

 AGC – Checking this box will enable automatic gain control on this channel. 

 

Moving the slider left or right decreases or increases the volume for this channel. 

 

Moving the slider to the left increases the volume on the left channel and 
decreases the volume on the right channel. Moving the slider to the right 
increases the sound on the right channel and decreases the sound on the left 
channel. 

Playback Settings Options 

The Options dialog box for playback settings allows you to mute the sound on 

this channel by checking the Enabled box associated with the Mute option. 

 

You can also set the amount of automatic gain control for this channel by first 

selecting the AGC option and then checking the Enabled box and selecting a 
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value in the Max gain: window. You can choose a value from 1 to 100. The 

default value is 15. 

 

Timeline View Menu Options 

Selecting a record in the Timeline view and then right-clicking on that record 

causes the Timeline View menu to appear, Figure 19. 

Except for Copy, Delete, Incident Properties, and Redaction Mode, the menu 

selections are the same as those in the Record View menu. Refer to the Record 

View Menu Options for information about those menu items. 

Figure 19. Timeline View Menu 

 

Selecting Copy from the Timeline View Menu allows you to copy the highlighted 

record information to the clipboard. 

Selecting Delete allows you to delete the selected record from the incident. 

Selecting Incident Properties displays the Incident Properties screen. Check 

the Save Audio With Incident box to have MediaWorks download all the media 

for each record in the incident. This will allow other users to listen to the audio 

or view the video without having a connection to your recorder. 
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 Note: The amount of audio or video could be quite large, depending on the number of 

records in the incident. In this case, it may take a few moments to download the 

media for each record, and the resulting file will grow accordingly. 

Check the Password Protect Incident box to have MediaWorks encrypt the 

incident with a case-sensitive password. When the incident is saved locally, you 

will be prompted for a password. Enter any combination of numbers and letters, 

and MediaWorks will encrypt the incident using this password. Anytime the 

incident is opened, you must provide the correct password to proceed.  

The Description: box allows you to provide additional information about the 

incident. Once you have completed entering the Incident Properties information, 

click the OK button. 

Checking the Redaction Mode box allows you to selectively remove specific 

sections of the record, provided you have selected the record from the Incident 

tab. The redactions will apply to both playback and export. Redactions are saved 

as part of an Incident. 

This is useful in cases where the recording may be played in a public venue 

such as a courtroom where, for security reasons, the redacted portions of the 

record cannot be exposed. 

To select a section, or sections, of a call record for redaction: 

1. From an Incident tab, right-click in the Timeline section to display the drop-

down menu. 

2. Check the Redaction Mode box. 

3. Click in a section of the call record where you want to redact a portion of the 

call. A redaction box will appear. 

You may increase or decrease the length of the box by dragging either the left 

or right border. You may insert more than one redaction box in a record by 

repeating these steps. 

You may remove a redaction box by right-clicking anywhere inside the box 

and selecting Remove. 

4. To exit the Redaction Mode, click in an empty area within the Timeline (i.e., 

not on a record) and uncheck the Redaction Mode box. 

4.4.5.  Playing Audio or Video Records 

Once you have located records from the Browse, Search, or Incident tabs, you 

have a number of options for playing the records. The following information 

describes the options for playing records in the Sequential mode. In this mode, 

records are played one record at a time, in the order in which they appear in the 

record list. To change the play order, sort the list of records differently. Playback 

will adapt to the new sequence. For information about playing records in the 

Mixed and Grouped modes, see Section 4.4.7.  Playback Modes. 
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Playing Audio Records 

To begin playing the audio from a record, press the Play button in the Playback 

console (see Section 4.4.6.  The Playback Console) at the bottom of the screen. 

The first record in the list will begin playing. To indicate where the playback is 

emanating from, a green arrow appears on the right side of the tab at the top of 

the screen and another green arrow appears to the left of the record in the 

Record pane. 

Alternatively, select a record and press Enter on the keyboard to begin 

playback, or press the Spacebar on the keyboard to begin, pause, and resume 

playback. Once the first record in the list has been selected, the Spacebar can 

only be used to pause and resume play. To select another record, highlight the 

record in the Record view or in the Timeline view and press the Enter key or 

double-click on the new record. The record will start playing immediately. Use 

the Spacebar or Pause button to stop playback and the Spacebar or Play button 

to resume playback. 

You may also use the sub-menu items in the Playback menu to control playback 

or right-click the desired record and select Start Sequential Playback from the 

drop-down menu. 

Playing Video Records 

To begin playing a video record, press the Play button in the Playback console 

(see Section 4.4.6.  The Playback Console) at the bottom of the screen. The first 

record in the list will begin playing. To indicate where the playback is emanating 

from, a green arrow appears on the right side of the tab at the top of the screen 

and another green arrow appears to the left of the record in the Record pane. 

Alternatively, select a record and press Enter on the keyboard to begin 

playback, or press the Spacebar on the keyboard to begin, pause, and resume 

playback. Once the first record in the list has been selected, the Spacebar can 

only be used to pause and resume play. To select another record, highlight the 

record in the Record view or the thumbnail in the Timeline view and press the 

Enter key or double-click on the new record. The record will start playing 

immediately. Use the Spacebar or Pause button to stop playback and the 

Spacebar or Play button to resume playback. 

You may also use the sub-menu items in the Playback menu to control playback 

or right-click the desired record and select Start Sequential Playback from the 

drop-down menu. 

When starting playback of a video record, a new pane displaying the video will 

appear in the upper right side of the main window above the Record list, Figure 

20. You may enlarge the video screen by right-clicking anywhere in the video 

screen area and choosing Detach from the drop-down menu. Once detached, 

you may expand the size of the screen by dragging on its sides. To restore the 
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screen to the upper right pane, right-click on the detached video and select 

Attach (or click on the X in the upper right corner of the screen). 

 Note: You can also increase or decrease the size of the screen by moving the divider 

bar between the Recorder view and Timeline view up or down. 

To select another record on the same channel for playback, double-click the 

record in the Record view or thumbnail in the Timeline view. The record will 

start playing immediately. 

Figure 20. Video Record 

 

4.4.6.  The Playback Console 

The Playback Console, located at the bottom of the main window (Figure 21), 

allows you to control all aspects of playing records. From the Playback Console 

you can adjust the volume and speed of the record being played: 

 Volume – Use this slider to increase or decrease the output volume of an 

audio record. Moving the slider to the right increases the volume; moving it 

to the left decreases the volume. Pressing the R button to the right of the 

slider will reset the slider to the default position of “0.” 

 Speed – Use this slider to increase or decrease the playing speed of the 

record. Moving the slider to the right increases the speed; moving it to the 

left decreases the speed. Pressing the R button to the right of the slider will 

reset the slider to the default position of “100%.” 
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Figure 21. Playback Console 

 

The buttons in the center of the console include: 

 Previous Record – If playback is less than 3 seconds into the record, moves 

to previous record in the selected sequence. If playback is more than 3 

seconds into the record, resets to the start of the current record. 

 Play – Plays any highlighted record, or resumes playback after pausing. 

 Pause – Pauses playback. 

 Next Record – Moves to the next record in the selected sequence. 

 Loop – Loops playback for the selected record or records. For sequential 

playback, this is the beginning and end of a record or the loop boundary 

settings within a single record. For mixed playback this is the loop boundary 

settings anywhere within the timeline. 

 Slider – The slider on the right side of the console allows you to change the 

playback position. This is known as scrubbing. You can scrub at anytime 

during playback. To quickly move to a different spot within a record, click 

and drag the scrub slider. While scrubbing, keep track of the position by 

watching the playback time indicator. 

Also, on the right side of the console, the double-arrow buttons on each side of 

the slider allow you to Skip Forward (>>) or Skip Back (<<) by the amount of 

time defined by the Skip Interval (see Skip Interval) option. 

While a record is being played, its attributes scroll right to left in the area above 

the playback controls. This information includes recording time, length of the 

record, the recorder from which the record was retrieved, and the record’s 

channel number. 

4.4.7.  Playback Modes 

MediaWorks supports three modes of playback: sequential, grouped, and mixed. 

Record data can be streamed from an Eventide recorder, from an offline archive, 

or from an incident containing embedded audio or video data. Optionally, 

playback can be modified to include “talking time” information. Audio volume 

and playback speed can both be adjusted, and seeking to random playback 

positions (scrubbing) is supported. 

For additional information about playback, see Section 3.3.6.  Playback Option. 
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Sequential Playback Mode 

Sequential playback occurs on one record at a time. The order in which records 

play is determined by the record view. To change the order in which sequential 

playback operates, change the sort order of the record view. 

To begin sequential playback, select Start Sequential Playback from the right-

click context menu in the Record or Timeline view. Alternatively, you can 

double-click a record or highlight a record and press the Enter key. 

Grouped Playback Mode 

Grouped playback is single play only and occurs when one record is related to 

another record in the database. For example, an audio record on one channel 

may have a related video record on another channel. If the audio record is 

selected and Start Grouped Playback is selected from the drop-down menu in 

the Record or Timeline view, both the audio record and its associated video will 

play. In this case, the video will not be displayed in the Timeline view, but the 

boundary markers (which will automatically be displayed) will encompass both 

records. 

If two linked records are adjacent on the timeline, they will both be displayed in 

the Grouped playback mode. 

To select the two channels for Grouped playback, select the first channel then 

hold down the Ctrl key and select the second (related) channel. 

To begin Grouped playback, select Start Grouped Playback from the drop-down 

menu in the Record or Timeline view. 

Mixed Playback Mode 

Mixed playback occurs on, potentially, many records at a time. The order in 

which records play is determined by the timeline. Mixed playback always 

proceeds in time order, from earliest to latest. For example, when examining 

records from a single channel, mixed playback would begin on the record that 

starts at the earliest time and proceed through each record in time order. On the 

other hand, if you are examining records from multiple channels, the case may 

be that multiple records occur at the same or overlapping times. In this case, 

mixed mode playback will play the data from all records that happen to occur at 

the same time and proceed through all records in time order. 

For example, if audio was recorded on “Dispatch 1” at the same time audio was 

recorded on “Emergency 5”, the audio for both records can be played back at the 

same time. When audio is playing in Mixed mode, you can easily follow the 

progress in the timeline, which highlights all playing records across all 

channels. 
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To select two or more channels for Mixed playback, select the first channel then 

hold down the Ctrl key to select individual additional channels, or the Shift key 

to select a range of channels. 

To begin mixed playback, select Start Mixed Playback from the drop-down 

menu in the Record or Timeline view. 

4.5.  Exporting Record Data from an Incident 

MediaWorks can export record data from a recorder in a number of different 

formats. The preferred way to export data is to first create an incident containing 

the records you wish to export. Refer to Section 4.2.  Creating an Incident for 

additional information. Once an incident has been created, select Export… from 

the Tools menu. The Export Media dialog box will appear, Figure 22. You can 

also right-click on the selected records in the Record view and choose Export… 

from the menu. 

To export record data: 

1. The first step in the Export Media dialog box, Select media, will be 

highlighted. Select All media in your record list? to export the media for all 

of the records in the incident, or select Only selected media in your record 

list? to export only selected records in the incident. Make your choice and 

then click the Next > button. 

Figure 22. Export Media Dialog Box 

 

2.  The second step, Select file divisions, will be highlighted. You may select 

One file per record (sequential), One file per timeline grouping (e.g. channel), 
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or One file for the entire record set (mixed). Make your choice and then click 

the Next > button. 

 

3. The third step, Select boundaries, will be highlighted. You can select the 

start and end time boundaries of the media to be exported (for Mixed exports 

only). Define a Start boundary and Stop boundary for the records. Check 

the Skip Inactive audio/video Periods box to skip the space between 

records. Check the Say date and time box if you wish to include an audio 

recording stating the date and time these records were exported. After 

making your selections, click the Next > button. 

 

4. If you are exporting audio records, the fourth step, Select audio options, 

will be highlighted. In the Audio compression box, select the type of data 

compression scheme you want to use. After selecting the audio options, click 

the Next > button. 
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5. If you are exporting video records, the fourth step, Select video options will 

be highlighted. Select the Video compression scheme, Video quality (Low, 

Medium, or High), and Video dimensions (Width and Height in pixels). After 

selecting the video options, click the Next > button. 

 

6. The fifth step, Select destination, will be highlighted. Check the Create 

text export listing if you would like to generate a text file of each of the 

records being exported. A text file containing a listing of all files exported in 

this session will be saved to the same folder as the exported data. 

7. For other than mixed exports, enter a destination path to the folder in which 

you wish to export your record data. For mixed exports you will also need to 

provide a file name. Click on the Browse… button to locate the directory. 

The path will appear in the Folder: box. 
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8. To Save these settings as a preset: enter a name for the preset in the box. 

The preset name can be any combination of alphanumeric characters that 

describe this preset. For example, you could call this “Audio Records Preset 

1.” If saved as a preset, you can reuse this same set of selections when 

exporting again by choosing Export Media Using Preset from the Tools 

menu. 

 

9. Finally, click on the Export button to export the record data to the chosen 

destination. 

4.6.  Exporting Record Data from Instant Recall 

MediaWorks can also export record data from an Instant Recall tab. From the 

Instant Recall tab, perform the following: 

1. Right-click on the record that you wish to export. 

2. Select Export selected from the drop down menu. The Select export file 

name screen, Figure 23 , will be displayed. 
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Figure 23. Select export file name Screen 

 

3. Using the arrows at the top of the screen, select the directory/folder to which 

you wish to export the record. This information will then be displayed in the 

Look in: box. 

4. At the bottom of the screen, enter a file name for the record you are 

exporting in the File name: box. 

5. Click on the Save button. An Export progress box will be displayed which 

will indicate the progress of exporting the record. 

 

6. When the exporting completes, click on the Close button. The exported 

record will now be saved in the directory/folder that you selected. 
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4.7.  Attaching Files to an Email 

MediaWorks allows you to attach record data from a recorder to an email. To do 

this, select Email… from the Tools menu. The Attaching files to email screen 

will appear, Figure 24. You can also right-click on the selected records in the 

Record view and choose Email… from the menu. 

To attach record data to an email: 

1. The first step in the Attach files to email screen, Select media, will be 

highlighted. Select All media in your record list? to export the media for all 

of the records listed, or select Only selected media in your record list? to 

export only selected records. Make your choice and then click the Next > 

button. 

Figure 24. Attach files to an email Screen 

 

2. The second step, Select file divisions, will be highlighted. You may select 

One file per record (sequential), One file per timeline grouping (e.g. channel), 

or One file for the entire record set (mixed). Make your choice and then click 

the Next > button. 
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3. The third step, Select boundaries, will be highlighted. You can select the 

start and end time boundaries of the media to be exported (for Mixed exports 

only). Define a Start boundary and Stop boundary for the records. Check 

the Skip Inactive audio/video Periods box to skip the space between 

records. Check the Say date and time box if you wish to include an audio 

recording stating the date and time these records were exported. After 

making your selections, click the Next > button. 

 

4. The fourth step, Select audio options, will be highlighted. The audio 

preferences only apply to files without a video component. Exports with video 

portions have embedded audio that does not necessarily obey these settings. 

For audio-only files, in the Audio compression box, select the type of data 

compression scheme you want to use. After selecting the audio options, click 

the Next > button. 
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5. The fifth step, Select destination, will be highlighted. To Save these 

settings as a preset: enter a name for the preset in the box. The preset 

name can be any combination of alphanumeric characters that describe this 

preset. For example, you could call this “Audio Records Preset 1.” If saved as 

a preset, you can reuse this same set of selections when emailing again by 

choosing Email Media Using Preset from the Tools menu. 

 

6. Click on the Export button to export the record data to an email. The Export 

progress dialog box will open, indicating the progress of the export. 
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When the export completes, an email box will appear, Figure 25, allowing 

you to address and send the email with the record data included as an 

attachment. 

Figure 25. Eventide Recordings Email 
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4.8.  Creating CDs 

Before creating a CD, you should first create an incident containing the records 

you wish to burn. Refer to Section 4.2.  Creating an Incident for additional 

information. Once an incident has been created, select Create CD… from the 

Tools menu. The Export Media dialog box will appear, Figure 26. Except for the 

Select destination entry, follow the same procedure as described in 

4.5.  Exporting Record Data from an Incident to create a CD containing the 

exported record data. 

You can also right-click on the selected records in the Record view and choose 

Create CD… from the menu. 

For the Select destination entry, you must choose whether you are burning the 

record information to an Audio CD or to a Data CD. Also, instead of a 

destination folder you will need to select the Drive containing the CD to be 

burned and specify the burning Speed. 

Figure 26. Creating a CD 

 

To Save these settings as a preset: enter a name for the preset in the box. The 

preset name can be any combination of alphanumeric characters that describe 

this preset. For example, you could call this “Audio Records Preset 1.” If saved 

as a preset, you can reuse this same set of selections when creating another CD 

by choosing Create CD Using Preset from the Tools menu. 

4.9.  Monitoring Recorders 

MediaWorks allows you to monitor the live audio feeds on a recorder. In 

addition, there are tools to monitor channel activity as well as the health and 

status of a recorder. 
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4.9.1.  Channels Tab 

The Channels tab, Figure 27, displays all physical channels in a list below each 

source and provides live status information for all physical channels on a 

recorder. To open a new Channels tab, select New Tab -> Channels from the 

File menu. 

Right-clicking anywhere in the screen below the column heads displays a drop-

down menu that includes two items: 

 Group – Checking this box groups the channels by their respective 

recorders. 

 Filter – Checking this box will filter out all channels that are not actively 

recording and display only those channels that are actively recording. 

If you check the Group by recorder box, each connected source appears in the 

Channels list. Expanding the tree information reveals all channels for that 

source. 

To sort the list of channels, click on either the Channel Name or Channel 

Number header; a small arrow will indicate the sort direction. To reverse the 

sort, click the header section again. 

Each channel is displayed with the Channel Name, Channel Number, and 

current Channel Status. To enable live monitoring of the data currently playing 

on a channel, toggle the Live Monitor icon for the selected channel. For a 

channel recording video information, when you select Live Monitor the video will 

be displayed in the upper half of the Channels tab screen. By right-clicking 

anywhere in the video area and choosing Detach, you may detach the video 

from the Channels screen and expand the size by dragging any of the borders. 

To restore the video to the Channels screen, right-click on the detached screen 

and select Attach (or click on the X in the upper right corner of the screen). 

To enable recording on a channel, check the Record Enabled checkbox. If the 

checkbox is deselected, any audio or video currently being recorded will stop 

until the Record Enabled checkbox is re-checked. Multiple channels can be 

monitored simultaneously. Adjust the overall volume level for an audio channel 

using the volume slider at the bottom of the window. 
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Figure 27. Channels Tab 

 

The status of each channel is displayed in the Channel Status column. A 

colored square indicates the current status. The colors correspond to the 

following states: 

 Green – The channel is enabled, but not recording any audio. 

 Red – The channel is enabled and recording audio. 

 Yellow – The channel is disabled. 

 Grey – The channel is disabled by the system or is not recognized. Consult 

your system administrator for details. 

You may add more columns by right-clicking on any area in the column headers 

and selecting one or more new columns from the drop-down list of column 

names. Check the box associated with each column name you wish to add and 

the new column will appear in the Channels tab. To remove a column, uncheck 

the box associated with that column. 

4.9.2.  Instant Recall Tab 

The Instant Recall tab, Figure 28, provides a live picture of the activity on a 

channel. By default, Instant Recall will contain filters for each channel name on 

a connected source. (To create customized filters, see Section 3.3.4.  Filters 

Options.) The records displayed in the record view will correspond to the 

selected filter, and will also correspond to the specified time range. To adjust the 

time range, enter a new value for Hours and Minutes. Instant Recall will 

automatically refresh the record view. 



   

66  Chap. 4.  Using MediaWorks MediaWorks User Manual v2.1   

 Note: Depending on your user account, the amount of time you can set may be limited 

by your system administrator. 

To change the channel that is displayed, select a new channel from the drop 

down list. The record view will again be automatically refreshed. Alternatively, 

you can refresh the record view by selecting Refresh from the Tools menu. 

Figure 28. Instant Recall Tab 

 

The Instant Recall record view can be customized in the same way as the 

Browse, Search, or Incident tabs. The types and number of columns, as well as 

the sort direction can all be changed. See Section 3.1.  Working with Windows 

and Tabs for more information. 

To play audio or video data in Instant Recall, double-click the desired record or 

highlight the record and press the Enter key. Playback of the audio or video 

data will begin. 

 Note: Instant Recall only supports sequential record playback. 

4.9.3.  Recorders Tab 

The Recorders tab, Figure 29, displays live drive and alarm information for 

connected sources. Select the recorder from the sources list to display the 

recorder’s status information. The drives reflect the current number and status 

of drives on the selected recorder. As drives are added or removed from the 

recorder, (for example, a network archive) the Drive status list will automatically 

be updated. The Alarms list will display the current active alarms on the source. 

As new alarms occur, the list will automatically be updated. To acknowledge an 

alarm, highlight the alarm and click on the Acknowledge button. Also, consult 

with your system administrator about any active alarms. 
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Figure 29. Recorders Tab 

 

4.10.  Accessing Archives 

Archives are historical records of calls that have been stored and maintained by 

the system administrator for future access and reference. Archives are typically 

made available through a designated location on a network drive, stand-alone 

media (DVD-RAM), or a dedicated recorder. 

 Note: For information on printing archive labels, see Section 4.11.  Printing Labels. 

4.10.1.  Accessing Archives on a Network or Local Drive 

To access archival records residing on a network drive, you must first add the 

drive’s location as a source. To locate the drive and add it as a source: 

1. Select Options from the Tools menu. 

2. When the Options screen displays, select Sources from list in the left pane 

and then click the Add button. The Add source screen will then be 

displayed, Figure 30. 

3. Select the Archive tab in the Add source screen. A directory listing is 

displayed, which includes all network drives to which you are connected. 

4. From the drop-down listing at the top of the screen, select the directory 

containing the archive data. Be sure the directory name is displayed in the 

Directory: box at the bottom of the screen. 
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5. Click the OK button to access the directory and search for record retrieval. 

Search and access the records in the same way you would on the recorder. 

Figure 30. Add Source - Archive Screen 

 

4.10.2.  Accessing Archives on DVD-RAM 

To locate records that have been archived on a DVD-RAM, perform the following: 

1. With the MediaWorks program running, insert the DVD-RAM disc into the 

drive on your PC. 

2. MediaWorks will automatically detect that the disc contains archives of call 

records and display an alert asking you: “Do you want to load the archive 

found at D:\?” 

3. Click the Yes button and MediaWorks will scan the disk’s contents and 

automatically load the records into the application. The archived records will 

subsequently be displayed in the channel area of the main screen. All 

records in the archive are now searchable and retrievable. 

4. If the auto-detect does not work, you can manually select the archive by 

selecting the DVD-RAM drive and then selecting the appropriate directory. 

 Note: An archive in the Search panel is displayed with a yellow rectangle preceding the 

archive name. Moving the mouse over the listing displays a tool tip naming the 

archive and the date range for the records it contains. 
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4.10.3.  Accessing Archives on a Recorder 

If the archives reside on a dedicated recorder, you can connect to that recorder 

just as you would any other recorder. 

1. Select Options from the Tools menu. 

2. When the Options screen displays, select Sources from list in the left pane 

and then click the Add button. The Add source screen will then be 

displayed, Figure 31.  

3. Select the Recorder tab in the Add source screen. 

Figure 31. Add Source - Recorder Screen 

 

4.  Enter the IP address of the recorder containing the archives in the Server: 

box. 

5. Enter your assigned user name and password in the User: and Password: 

boxes respectively. 

6. Click the OK button. The recorder will now be displayed in the Sources box. 

The archive on the recorder is displayed as its own entity, both in the 

Options/Source screen and in the Channel section of the Search panel of the 

MediaWorks main screen. 

All records in the archive are now ready to be actively searched and accessed. 

4.11.  Printing Labels 

MediaWorks allows you to use a client-based label printer to print labels for 

identifying media and archives. For example, you can print a label for a DVD-
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RAM archive that was created on a connected recorder. The label will include 

identifying information for the archive, such as the dates of the first and last 

calls.  

Client-based Label Printers: These printers connect to a Microsoft Windows* 

PC and print through the Eventide MediaWorks program. The supported 

printers include the Seiko* Smart Label Printer SLP-440 and the Dymo* 

LabelWriter 450 Professional Label Printer.  

Requirements 

 Client-based label printing is supported in Eventide MediaWorks v1.9.5 or 

later with recorders using NexLog or Atlas Recorder software v1.9.5 or later. 

It will not work with versions prior to this.  

 Before printing archive labels, the recorder where the archiving occurred 

must be accessible. (See Section 2.2.  Starting MediaWorks and Adding a 

Source and Section 3.3.1.  Sources Options).  

 The label printer must be installed and working. (Follow the setup 

instructions that came with the label printer.) See also the following Printer 

Setup Tips. 

Printer Setup Tips 

After you have installed your label printer, it is a good idea to set the Printing 

Defaults and Printing Preferences to work with Eventide MediaWorks. This 

includes setting the label size and orientation. Use the following guidelines to 

configure the settings.  

1. Open the printer properties. You can do this from the Microsoft Windows* 

Start menu, by opening Control Panel, Printers and Faxes, and selecting 

your label printer. Then from the Printer menu, select Properties.  

2. Set the label size and orientation in Printing Preferences. These can be found 

in Properties by clicking the Printing Preferences button on the General 

tab. Then, on the Layout tab, click on Landscape Orientation. Then, click 

the Advanced button and click on the Paper Size that is closest to the 

labels that you are using. Click the OK button to accept the paper size 

settings. Click the OK button to accept the Printing Preferences settings.  

3. Also, set the same label size and orientation in Printing Defaults (for all 

users). The Printing Defaults button is usually found on the Advanced tab. 

Make the same changes as you did for Printing Preferences. 

Archive List Label Printing 

On the Tools menu, select Archive List, which allows you to print labels for 

archived data. 
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The Archive List screen, Figure 32, displays a list of connected recorders on the 

left, and on the right, a list of archives that have been created by the selected 

recorder. (The screen can be enlarged by clicking and dragging the borders.)  

Figure 32. Archive List 

 

 

The list of archives on the right shows the most recent archive at the top (the 

highest archive ID). You can also sort the list in ascending or descending order 

by clicking on any column heading once or twice.  

To print an archive label, select the recorder on the left side, and then select the 

desired archive on the right side. Click the Print Label button. (If you click the 

Print Label button without selecting an archive, the most recent archive in list 

will be selected for you.) This displays a standard Microsoft Windows printer 

dialog. Select the label printer and click OK.  

4.12.  Generating Reports 

MediaWorks has the capability of creating multiple types of reports by 

generating: 

 A report from an active search. 

 A report using the Reports screen. 

4.12.1.  Generating a Report From an Active Search 

MediaWorks can generate the following types of reports using an active search: 

 Selected Records 

 All Records 

To generate a report listing either selected records or all records from your most 

recent search, perform the following: 
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1. Select Print Records… from the File menu. The Print Records screen, 

Figure 33, will be displayed. 

Figure 33. Print Records Screen 

 

2. Select either Selected Records or All Records from the Print Records 

Options screen. This action automatically launches an HTML-based 

rendering of the report in your default browser. 

Note: If you choose Selected Records, you must first highlight one or more 

records from your search results. 

3. To include the notes associated with the records, check the Include Notes 

box. 

4. To include the audit history associated with the records, check the Include 

Audit History box. 

5. After reviewing the listing, click the Print button to create a hard copy of the 

report, Figure 34. 
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Figure 34. Call Records Report 

 

4.12.2.  Generating a Report From the Reports Screen 

The MediaWorks Reports screen provides three predefined report types: 

 Channel Activity Summary 

 Daily Statistics Summary 

 Channel Activity 

Channel Activity Summary Report 

The Channel Activity Summary report logs all channel activity by date range.  

To generate a Channel Activity Summary report, perform the following: 

1. Select More Reports… from the File menu. This will cause the Reports 

screen to display, Figure 35. 

2. From the Reports screen, select Channel Activity Summary. 
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Figure 35. Reports Screen 

 

3. Select the recorder on which you wish to generate the report. 

4. Select a Start date and time and an End date and time. Then click the Run 

Report button. MediaWorks will now generate a Channel Activity Summary 

report. 

5. After reviewing the listing, click Print from your browser’s File menu to 

create a hard copy of the report, Figure 36. 

Figure 36. Channel Activity Summary Report 

 

 Note: The Channels and Interval selection areas are disabled for the Channel Activity 

Summary report. 
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Daily Statistics Summary Report 

The Daily Statistics Summary report details all activity for the selected recorder 

by individual date(s).  

To generate a Daily Statistics Summary report, perform the following: 

1. Select More Reports… from the File menu. This will cause the Reports 

screen to display. 

2. From the Reports screen, select Daily Statistics Summary. 

3. Select the recorder on which you wish to generate the report. 

4. Select a Start date and time and an End date and time. Then click the Run 

Report button. MediaWorks will now generate a Daily Statistics Summary 

report. 

5. After reviewing the listing, click Print from your browser’s File menu to 

create a hard copy of the report, Figure 37. 

Figure 37. Data Statistics Summary Report 
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Channel Activity Report 

The Channel Activity report logs all channel activity for the selected channel(s) 

on the selected recorder by date range. 

To generate a Channel Activity report, perform the following: 

1. Select More Reports… from the File menu. This will cause the Reports 

screen to display, Figure 38. 

2. From the Reports screen, select Channel Activity. 

3. Select the recorder on which you wish to generate the report. 

4. Highlight the channel or channels to include in the report. 

Figure 38. Channel Activity Screen 

 

5. Select a Start date and time and an End date and time. 

6. Select a time Interval. The shorter the time interval you select, the more 

frequent the reporting cycles will occur in the report. 

7. Click the Run Report button. MediaWorks will now generate a Channel 

Activity report. 

8. After reviewing the listing, click Print from your browser’s File menu to 

create a hard copy of the report, Figure 39. 
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Figure 39. Channel Activity Report 
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  

5.  Frequently Asked Questions 

Question Answer 

How can I work with an incident in Microsoft Excel? Information can be moved to Microsoft Excel using 

the copy and paste commands. In any record view, 

first select one or more records. Then copy the 

record to the clipboard. Switch to Excel and paste 

the information into the spread sheet. 

I need to mail an incident to someone. How do I 

include the audio with the list of records? 

MediaWorks supports this as an option for local 

incidents. With the local incident open, press the 

Properties button. In the dialog box that appears, 

ensure that the Save Audio With Incident box is 

checked. When the incident is saved, the audio data 

will be downloaded and saved within the incident. 

After the audio is downloaded, you can email the 

incident to someone and they will be able to open 

the email and listen to the audio without needing 

access to the recorder. 

Why can’t I drag a single record and append it to an 

open incident? 

From the Tools  Options  General menu, check 

that the Enable ‘drag selection’ in record view 

box is not checked. When this option is enabled, 

clicking and dragging in a record view will initiate a 

selection operation. A second click is required 

within the selection to begin dragging the selected 

records. Disabling this option will allow a click + 

drag to start dragging the selected records 

immediately. 

How can I search for records across more than a 

single month? 

The calendar in the Search tab allows you to select 

records across more than one month. After selecting 

one or more days in one month in the calendar, 

click the forward or backward arrow to navigate to a 

different month. While holding the Ctrl key down, 

select additional days in the second month. 

If you need to select a range of days across more 

than one month, hold down the Shift key before 

selecting the days in the first month. When you do 

this, the range of days from your first selection can 

be carried across to second month, as long as you 

hold the Shift key down during the selection 
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Question Answer 

process. 

Alternatively, you may select the Date Range mode 

from the Date drop-down menu. 

How do I play back a set of records in the Mixed 

mode? 

You can play back records in the Mixed mode from 

the Search, Browse, or Incident tab by right-clicking 

the list of records and selecting Start Mixed 

Playback from the drop-down menu.  

You can also start mixed playback from the 

Timeline by right-clicking a particular time and 

selecting Start Mixed Playback. 

I don’t see any sources when I try to Browse or  

Search for records. Where did the records go? 

MediaWorks will remember all of the sources you 

have ever added. If a recorder becomes unavailable 

(for example, it is powered down for maintenance), 

you may need to reestablish a connection to it. 

From the Tools  Options  Sources menu, locate 

your recorder in the list and click the Connect 

button to reconnect to it. If your recorder does not 

appear in the list, you will need to add it. For more 

information about adding a recorder, see Section 

3.3.1.  Sources Options. 

I’ve found a problem with MediaWorks. What 

should I do? 

In addition to the Frequently Asked Questions, you 

should consult any release notes for information 

regarding your version of MediaWorks. 

Also, see Chapter 6.  Reporting Problems. 
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  

6.  Reporting Problems 

It is Eventide’s policy to work directly with dealers, not end users. Your dealer 

must report your problem to Eventide with the following information in order to 

process the service/support request: 

 Serial number(s) of the affected recorder(s). 

 Software versions for both the recorder(s) and MediaWorks. 

 Severity of the issue, including a detailed description. 

 Contact information (phone and email) for the dealer and on-site technician. 

To contact Eventide customer service for support, call 201-641-1200 Option 6 

followed by Option 2 (Communications/Recorders Division) or email 

support@eventide.com. 

mailto:support@eventide.com
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